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Preface

This book was written by Michael Margolis with Nick Weldin to help you explore the
amazing things you can do with Arduino.

Arduino is a family of microcontrollers (tiny computers) and a software creation envi-
ronment that makes it easy for you to create programs (called sketches) that can interact
with the physical world. Things you make with Arduino can sense and respond to
touch, sound, position, heat, and light. This type of technology, often referred to as
physical computing, is used in all kinds of things from the iPhone to automobile elec-
tronics systems. Arduino makes it possible for anyone with an interest—even people
with no programming or electronics experience—to use this rich and complex
technology.

Who This Book Is For
Unlike in most technical cookbooks, experience with software and hardware is not
assumed. This book is aimed at readers interested in using computer technology to
interact with the environment. It is for people who want to quickly find the solution to
hardware and software problems. The recipes provide the information you need to
accomplish a broad range of tasks. It also has details to help you customize solutions
to meet your specific needs. There is insufficient space in a book limited to 700 pages
to cover general theoretical background, so links to external references are provided
throughout the book. See “What Was Left Out” on page xiv for some general refer-
ences for those with no programming or electronics experience.

If you have no programming experience—perhaps you have a great idea for an inter-
active project but don’t have the skills to develop it—this book will help you learn what
you need to know to write code that works, using examples that cover over 200 com-
mon tasks.

If you have some programming experience but are new to Arduino, the book will help
you become productive quickly by demonstrating how to implement specific Arduino
capabilities for your project.
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People already using Arduino should find the content helpful for quickly learning new
techniques, which are explained using practical examples. This will help you to embark
on more complex projects by showing how to solve problems and use capabilities that
may be new to you.

Experienced C/C++ programmers will find examples of how to use the low-level AVR
resources (interrupts, timers, I2C, Ethernet, etc.) to build applications using the
Arduino environment.

How This Book Is Organized
The book contains information that covers the broad range of the Arduino’s capabili-
ties, from basic concepts and common tasks to advanced technology. Each technique
is explained in a recipe that shows you how to implement a specific capability. You do
not need to read the content in sequence. Where a recipe uses a technique covered in
another recipe, the content in the other recipe is referenced rather than repeating details
in multiple places.

Chapter 1, Getting Started, introduces the Arduino environment and provides help on
getting the Arduino development environment and hardware installed and working.

The next couple of chapters introduce Arduino software development. Chapter 2,
Making the Sketch Do Your Bidding, covers essential software concepts and tasks, and
Chapter 3, Using Mathematical Operators, shows how to make use of the most common
mathematical functions.

Chapter 4, Serial Communications, describes how to get Arduino to connect and com-
municate with your computer and other devices. Serial is the most common method
for Arduino input and output, and this capability is used in many of the recipes
throughout the book.

Chapter 5, Simple Digital and Analog Input, introduces a range of basic techniques for
reading digital and analog signals. Chapter 6, Getting Input from Sensors, builds on this
with recipes that explain how to use devices that enable Arduino to sense touch, sound,
position, heat, and light.

Chapter 7, Visual Output, covers controlling light. Recipes cover switching on one or
many LEDs and controlling brightness and color. This chapter explains how you can
drive bar graphs and numeric LED displays, as well as create patterns and animations
with LED arrays. In addition, the chapter provides a general introduction to digital and
analog output for those who are new to this.

Chapter 8, Physical Output, explains how you can make things move by controlling
motors with Arduino. A wide range of motor types is covered: solenoids, servo motors,
DC motors, and stepper motors.
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Chapter 9, Audio Output, shows how to generate sound with Arduino through an out-
put device such as a speaker. It covers playing simple tones and melodies and playing
WAV files and MIDI.

Chapter 10, Remotely Controlling External Devices, describes techniques that can be
used to interact with almost any device that uses some form of remote controller, in-
cluding TV, audio equipment, cameras, garage doors, appliances, and toys. It builds
on techniques used in previous chapters for connecting Arduino to devices and
modules.

Chapter 11, Using Displays, covers interfacing text and graphical LCD displays. The
chapter shows how you can connect these devices to display text, scroll or highlight
words, and create special symbols and characters.

Chapter 12, Using Time and Dates, covers built-in Arduino time-related functions and
introduces many additional techniques for handling time delays, time measurement,
and real-world times and dates.

Chapter 13, Communicating Using I2C and SPI, covers the Inter-Integrated Circuit
(I2C) and Serial Peripheral Interface (SPI) standards. These standards provide simple
ways for digital information to be transferred between sensors and Arduino. This chap-
ter shows how to use I2C and SPI to connect to common devices. It also shows how to
connect two or more Arduino boards, using I2C for multiboard applications.

Chapter 14, Wireless Communication, covers wireless communication with XBee and
other wireless modules. This chapter provides examples ranging from simple wireless
serial port replacements to mesh networks connecting multiple boards to multiple
sensors.

Chapter 15, Ethernet and Networking, describes the many ways you can use Arduino
with the Internet. It has examples that demonstrate how to build and use web clients
and servers and shows how to use the most common Internet communication protocols
with Arduino.

Arduino software libraries are a standard way of adding functionality to the Arduino
environment. Chapter 16, Using, Modifying, and Creating Libraries, explains how to
use and modify software libraries. It also provides guidance on how to create your own
libraries.

Chapter 17, Advanced Coding and Memory Handling, covers advanced programming
techniques, and the topics here are more technical than the other recipes in this book
because they cover things that are usually concealed by the friendly Arduino wrapper.
The techniques in this chapter can be used to make a sketch more efficient—they can
help improve performance and reduce the code size of your sketches.

Chapter 18, Using the Controller Chip Hardware, shows how to access and use hard-
ware functions that are not fully exposed through the documented Arduino language.
It covers low-level usage of the hardware input/output registers, timers, and interrupts.
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Appendix A, Electronic Components, provides an overview of the components used
throughout the book.

Appendix B, Using Schematic Diagrams and Data Sheets, explains how to use schematic
diagrams and data sheets.

Appendix C, Building and Connecting the Circuit, provides a brief introduction to using
a breadboard, connecting and using external power supplies and batteries, and using
capacitors for decoupling.

Appendix D, Tips on Troubleshooting Software Problems, provides tips on fixing com-
pile and runtime problems.

Appendix E, Tips on Troubleshooting Hardware Problems, covers problems with elec-
tronic circuits.

Appendix F, Digital and Analog Pins, provides tables indicating functionality provided
by the pins on standard Arduino boards.

Appendix G, ASCII and Extended Character Sets, provides tables showing ASCII
characters.

Appendix H, Migrating to Arduino 1.0, explains how to modify code written for pre-
vious releases to run correctly with Arduino 1.0.

What Was Left Out
There isn’t room in this book to cover electronics theory and practice, although guid-
ance is provided for building the circuits used in the recipes. For more detail, readers
may want to refer to material that is widely available on the Internet or to books such
as the following:

• Make: Electronics by Charles Platt (O’Reilly; search for it on oreilly.com)

• Getting Started in Electronics by Forrest M. Mims III (Master Publishing)

• Physical Computing by Dan O’Sullivan and Tom Igoe (Cengage)

• Practical Electronics for Inventors by Paul Scherz (McGraw-Hill)

This cookbook explains how to write code to accomplish specific tasks, but it is not an
introduction to programming. Relevant programming concepts are briefly explained,
but there is insufficient room to cover the details. If you want to learn more about
programming, you may want to refer to the Internet or to one of the following books:

• Practical C Programming by Steve Oualline (O’Reilly; search for it on oreilly.com)

• A Book on C by Al Kelley and Ira Pohl (Addison-Wesley)
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My favorite, although not really a beginner’s book, is the book I used to learn
C programming:

• The C Programming Language by Brian W. Kernighan and Dennis M. Ritchie
(Prentice Hall)

Code Style (About the Code)
The code used throughout this book has been tailored to clearly illustrate the topic
covered in each recipe. As a consequence, some common coding shortcuts have been
avoided, particularly in the early chapters. Experienced C programmers often use rich
but terse expressions that are efficient but can be a little difficult for beginners to read.
For example, the early chapters increment variables using explicit expressions that are
easy for nonprogrammers to read:

    result = result + 1; // increment the count

Rather than the following, commonly used by experienced programmers, that does the
same thing:

   result++;  // increment using the post increment operator

Feel free to substitute your preferred style. Beginners should be reassured that there is
no benefit in performance or code size in using the terse form.

Some programming expressions are so common that they are used in their terse form.
For example, the loop expressions are written as follows:

for(int i=0; i < 4; i++)

This is equivalent to the following:

int i;
for(i=0; i < 4; i = i+1)

See Chapter 2 for more details on these and other expressions used throughout the
book.

Good programming practice involves ensuring that values used are valid (garbage in
equals garbage out) by checking them before using them in calculations. However, to
keep the code focused on the recipe topic, very little error-checking code has been
included.

Arduino Platform Release Notes
This edition has been updated for Arduino 1.0. All of the code has been tested with the
latest Arduino 1.0 release candidate at the time of going to press (RC2). The download
code for this edition will be updated online if necessary to support the final 1.0 release,
so check the book’s website to get the latest code. The download contains a file named
changelog.txt that will indicate code that has changed from the published edition.
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Although many of the sketches will run on earlier Arduino releases, you need to change
the extension from .ino to .pde to load the sketch into a pre-1.0 IDE. If you have not
migrated to Arduino 1.0 and have good reason to stick with an earlier release, you can
use the example code from the first edition of this book (available at http://shop.oreilly
.com/product/9780596802486.do), which has been tested with releases from 0018 to
0022. Note that many recipes in the second edition have been enhanced, so we en-
courage you to upgrade to Arduino 1.0. If you need help migrating older code, see
Appendix H.

There’s also a link to errata on that site. Errata give readers a way to let us know about
typos, errors, and other problems with the book. Errata will be visible on the page
immediately, and we’ll confirm them after checking them out. O’Reilly can also fix
errata in future printings of the book and on Safari, making for a better reader experi-
ence pretty quickly.

If you have problems making examples work, check the changelog.txt file in the latest
code download to see if the sketch has been updated. If that doesn’t fix the problem,
see Appendix D, which covers troubleshooting software problems. The Arduino forum
is a good place to post a question if you need more help: http://www.arduino.cc.

If you like—or don’t like—this book, by all means, please let people know. Amazon
reviews are one popular way to share your happiness or other comments. You can also
leave reviews at the O’Reilly site for the book.

Conventions Used in This Book
The following font conventions are used in this book:

Italic
Indicates pathnames, filenames, and program names; Internet addresses, such as
domain names and URLs; and new items where they are defined

Constant width
Indicates command lines and options that should be typed verbatim; names and
keywords in programs, including method names, variable names, and class names;
and HTML element tags

Constant width bold
Indicates emphasis in program code lines

Constant width italic
Indicates text that should be replaced with user-supplied values

This icon signifies a tip, suggestion, or general note.
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This icon indicates a warning or caution.

Using Code Examples
This book is here to help you make things with Arduino. In general, you may use the
code in this book in your programs and documentation. You do not need to contact
us for permission unless you’re reproducing a significant portion of the code. For ex-
ample, writing a program that uses several chunks of code from this book does not
require permission. Selling or distributing a CD-ROM of examples from this book
does require permission. Answering a question by citing this book and quoting example
code does not require permission. Incorporating a significant amount of example code
from this book into your product’s documentation does require permission.

We appreciate, but do not require, attribution. An attribution usually includes the title,
author, publisher, and ISBN. For example: “Arduino Cookbook, Second Edition, by
Michael Margolis with Nick Weldin (O’Reilly). Copyright 2012 Michael Margolis,
Nicholas Weldin, 978-1-4493-1387-6.”

If you feel your use of code examples falls outside fair use or the permission given here,
feel free to contact us at permissions@oreilly.com.

Safari® Books Online
Safari Books Online is an on-demand digital library that lets you easily
search over 7,500 technology and creative reference books and videos to
find the answers you need quickly.

With a subscription, you can read any page and watch any video from our library online.
Read books on your cell phone and mobile devices. Access new titles before they are
available for print, and get exclusive access to manuscripts in development and post
feedback for the authors. Copy and paste code samples, organize your favorites, down-
load chapters, bookmark key sections, create notes, print out pages, and benefit from
tons of other time-saving features.

O’Reilly Media has uploaded this book to the Safari Books Online service. To have full
digital access to this book and others on similar topics from O’Reilly and other pub-
lishers, sign up for free at http://my.safaribooksonline.com.

How to Contact Us
We have tested and verified the information in this book to the best of our ability, but
you may find that features have changed (or even that we have made a few mistakes!).
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Please let us know about any errors you find, as well as your suggestions for future
editions, by writing to:

O’Reilly Media, Inc.
1005 Gravenstein Highway North
Sebastopol, CA 95472
800-998-9938 (in the United States or Canada)
707-829-0515 (international/local)
707-829-0104 (fax)

We have a web page for this book, where we list errata, examples, and any additional
information. You can access this page at:

http://shop.oreilly.com/product/0636920022244.do

To comment or ask technical questions about this book, send email to:

bookquestions@oreilly.com

For more information about our books, courses, conferences, and news, see our website
at http://www.oreilly.com.

Find us on Facebook: http://facebook.com/oreilly

Follow us on Twitter: http://twitter.com/oreillymedia

Watch us on YouTube: http://www.youtube.com/oreillymedia
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CHAPTER 1

Getting Started

1.0  Introduction
The Arduino environment has been designed to be easy to use for beginners who have
no software or electronics experience. With Arduino, you can build objects that can
respond to and/or control light, sound, touch, and movement. Arduino has been used
to create an amazing variety of things, including musical instruments, robots, light
sculptures, games, interactive furniture, and even interactive clothing.

If you’re not a beginner, please feel free to skip ahead to recipes that
interest you.

Arduino is used in many educational programs around the world, particularly by de-
signers and artists who want to easily create prototypes but do not need a deep under-
standing of the technical details behind their creations. Because it is designed to be used
by nontechnical people, the software includes plenty of example code to demonstrate
how to use the Arduino board’s various facilities.

Though it is easy to use, Arduino’s underlying hardware works at the same level of
sophistication that engineers employ to build embedded devices. People already work-
ing with microcontrollers are also attracted to Arduino because of its agile development
capabilities and its facility for quick implementation of ideas.

Arduino is best known for its hardware, but you also need software to program that
hardware. Both the hardware and the software are called “Arduino.” The combination
enables you to create projects that sense and control the physical world. The software
is free, open source, and cross-platform. The boards are inexpensive to buy, or you can
build your own (the hardware designs are also open source). In addition, there is an
active and supportive Arduino community that is accessible worldwide through the
Arduino forums and the wiki (known as the Arduino Playground). The forums and the
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wiki offer project development examples and solutions to problems that can provide
inspiration and assistance as you pursue your own projects.

The recipes in this chapter will get you started by explaining how to set up the devel-
opment environment and how to compile and run an example sketch.

Source code containing computer instructions for controlling Arduino
functionality is usually referred to as a sketch in the Arduino community.
The word sketch will be used throughout this book to refer to Arduino
program code.

The Blink sketch, which comes with Arduino, is used as an example for recipes in this
chapter, though the last recipe in the chapter goes further by adding sound and col-
lecting input through some additional hardware, not just blinking the light built into
the board. Chapter 2 covers how to structure a sketch for Arduino and provides an
introduction to programming.

If you already know your way around Arduino basics, feel free to jump
forward to later chapters. If you’re a first-time Arduino user, patience
in these early recipes will pay off with smoother results later.

Arduino Software
Software programs, called sketches, are created on a computer using the Arduino inte-
grated development environment (IDE). The IDE enables you to write and edit code
and convert this code into instructions that Arduino hardware understands. The IDE
also transfers those instructions to the Arduino board (a process called uploading).

Arduino Hardware
The Arduino board is where the code you write is executed. The board can only control
and respond to electricity, so specific components are attached to it to enable it to
interact with the real world. These components can be sensors, which convert some
aspect of the physical world to electricity so that the board can sense it, or actuators,
which get electricity from the board and convert it into something that changes the
world. Examples of sensors include switches, accelerometers, and ultrasound distance
sensors. Actuators are things like lights and LEDs, speakers, motors, and displays.

There are a variety of official boards that you can use with Arduino software and a wide
range of Arduino-compatible boards produced by members of the community.

The most popular boards contain a USB connector that is used to provide power and
connectivity for uploading your software onto the board. Figure 1-1 shows a basic board
that most people start with, the Arduino Uno.
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The Arduino Uno has a second microcontroller onboard to handle all USB communi-
cation; the small surface-mount chip (the ATmega8U2) is located near the USB socket
on the board. This can be programmed separately to enable the board to appear as
different USB devices (see Recipe 18.14 for an example). The Arduino Leonardo board
replaces the ATmega8U2 and the ATmega328 controllers with a single ATmega32u4
chip that implements the USB protocol in software. The Arduino-compatible Teensy
and Teensy+ boards from PJRC (http://www.pjrc.com/teensy/) are also capable of em-
ulating USB devices. Older boards, and most of the Arduino-compatible boards, use a
chip from the FTDI company that provides a hardware USB solution for connection to
the serial port of your computer.

You can get boards as small as a postage stamp, such as the Arduino Mini and Pro Mini;
larger boards that have more connection options and more powerful processors, such
as the Arduino Mega; and boards tailored for specific applications, such as the LilyPad
for wearable applications, the Fio for wireless projects, and the Arduino Pro for em-
bedded applications (standalone projects that are often battery-operated).

Recent additions to the range include the Arduino ADK, which has a USB host socket
on it and is compatible with the Android Open Accessory Development Kit, the offi-
cially approved method of attaching hardware to Android devices. The Leonardo board
uses a controller chip (the ATmega32u4) that is able to present itself as various HID

Figure 1-1. Basic board: the Arduino Uno. Photograph courtesy todo.to.it.
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devices. The Ethernet board includes Ethernet connectivity, and has a Power Over
Ethernet option, so it is possible to use a single cable to connect and power the board.

Other Arduino-compatible boards are also available, including the following:

• Arduino Nano, a tiny board with USB capability, from Gravitech (http://store.grav
itech.us/arna30wiatn.html)

• Bare Bones Board, a low-cost board available with or without USB capability, from
Modern Device (http://www.moderndevice.com/products/bbb-kit)

• Boarduino, a low-cost breadboard-compatible board, from Adafruit Industries
(http://www.adafruit.com/)

• Seeeduino, a flexible variation of the standard USB board, from Seeed Studio
Bazaar (http://www.seeedstudio.com/)

• Teensy and Teensy++, tiny but extremely versatile boards, from PJRC (http://www
.pjrc.com/teensy/)

A list of Arduino-compatible boards is available at http://www.freeduino.org/.

See Also
An overview of Arduino boards: http://www.arduino.cc/en/Main/Hardware.

Online guides for getting started with Arduino are available at http://arduino.cc/en/
Guide/Windows for Windows, http://arduino.cc/en/Guide/MacOSX for Mac OS X, and
http://www.arduino.cc/playground/Learning/Linux for Linux.

A list of over a hundred boards that can be used with the Arduino development envi-
ronment can be found at: http://jmsarduino.blogspot.com/2009/03/comprehensive-ardu
ino-compatible.html

1.1  Installing the Integrated Development Environment (IDE)
Problem
You want to install the Arduino development environment on your computer.

Solution
The Arduino software for Windows, Mac, and Linux can be downloaded from http://
arduino.cc/en/Main/Software.

The Windows download is a ZIP file. Unzip the file to any convenient directory—
Program Files/Arduino is a sensible place.
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A free utility for unzipping files, called 7-Zip, can be downloaded from
http://www.7-zip.org/.

Unzipping the file will create a folder named Arduino-00<nn> (where <nn> is the ver-
sion number of the Arduino release you downloaded). The directory contains the
executable file (named Arduino.exe), along with various other files and folders. Double-
click the Arduino.exe file and the splash screen should appear (see Figure 1-2), followed
by the main program window (see Figure 1-3). Be patient, as it can take some time for
the software to load.

Figure 1-2. Arduino splash screen (Version 1.0 in Windows 7)

The Arduino download for the Mac is a disk image (.dmg); double-click the file when
the download is complete. The image will mount (it will appear like a memory stick

1.1  Installing the Integrated Development Environment (IDE) | 5

http://www.7-zip.org/


on the desktop). Inside the disk image is the Arduino application. Copy this to
somewhere convenient—the Applications folder is a sensible place. Double-click the
application once you have copied it over (it is not a good idea to run it from the disk
image). The splash screen will appear, followed by the main program window.

Linux installation varies depending on the Linux distribution you are using. See the
Arduino wiki for information (http://www.arduino.cc/playground/Learning/Linux).

To enable the Arduino development environment to communicate with the board, you
need to install drivers.

On Windows, use the USB cable to connect your PC and the Arduino board and wait
for the Found New Hardware Wizard to appear. If you are using an Uno board, let the
wizard attempt to find and install drivers. It will fail to do this (don’t worry, this is the
expected behavior). To fix it you now need to go to Start Menu→Control Panel→System

Figure 1-3. IDE main window (Arduino 1.0 on a Mac)
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and Security. Click on System, and then open Device Manager. In the listing that is
displayed find the entry in COM and LPT named Arduino UNO (COM nn). nn will be the
number Windows has assigned to the port created for the board. You will see a warning
logo next to this because the appropriate drivers have not yet been assigned. Right click
on the entry and select Update Driver Software. Choose the “Browse my computer for
driver software” option, and navigate to the Drivers folder inside the Arduino folder
you just unzipped. Select the ArduinoUNO.inf file and windows should then complete
the installation process.

If you are using an earlier board (any board that uses FTDI drivers) with Windows Vista
or Windows 7 and are online, you can let the wizard search for drivers and they will
install automatically. On Windows XP (or if you don’t have Internet access), you should
specify the location of the drivers. Use the file selector to navigate to the FTDI USB
Drivers directory, located in the directory where you unzipped the Arduino files. When
this driver has installed, the Found New Hardware Wizard will appear again, saying a
new serial port has been found. Follow the same process as before.

It is important that you go through the sequence of steps to install the
drivers two times, or the software will not be able to communicate with
the board.

On the Mac, the latest Arduino boards, such as the Uno, can be used without additional
drivers. When you first plug the board in a notification will pop up saying a new net-
work port has been found, you can dismiss this. If you are using earlier boards (boards
that need FTDI drivers), you will need to install driver software. There is a package
named FTDIUSBSerialDriver, with a range of numbers after it, inside the disk image.
Double-click this and the installer will take you through the process. You will need to
know an administrator password to complete the process.

On Linux, most distributions have the driver already installed, but follow the Linux
link given in this chapter’s introduction for specific information for your distribution.

Discussion
If the software fails to start, check the troubleshooting section of the Arduino website,
http://arduino.cc/en/Guide/Troubleshooting, for help solving installation problems.

See Also
Online guides for getting started with Arduino are available at http://arduino.cc/en/
Guide/Windows for Windows, http://arduino.cc/en/Guide/MacOSX for Mac OS X, and
http://www.arduino.cc/playground/Learning/Linux for Linux.
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1.2  Setting Up the Arduino Board
Problem
You want to power up a new board and verify that it is working.

Solution
Plug the board in to a USB port on your computer and check that the green LED power
indicator on the board illuminates. Standard Arduino boards (Uno, Duemilanove, and
Mega) have a green LED power indicator located near the reset switch.

An orange LED near the center of the board (labeled “Pin 13 LED” in Figure 1-4) should
flash on and off when the board is powered up (boards come from the factory preloaded
with software to flash the LED as a simple check that the board is working).

Figure 1-4. Basic Arduino board (Duemilanove and Uno)

New boards such as Leonardo have the LEDs located near the USB connector; see
Figure 1-5. Recent boards have duplicate pins for use with I2C (marked SCL and SDA).
These boards also have a pin marked IOREF that can be used to determine the operating
voltage of the chip.
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The latest boards have three additional connections in the new standard
for connector layout on the board. This does not affect the use of older
shields (they will all continue to work with the new boards, just as they
did with earlier boards). The new connections provide a pin (IOREF)
for shields to detect the analog reference voltage (so that analog input
values can be calibrated to the supply voltage), SCL and SDA pins to
enable a consistent connection for I2C devices (the location of the I2C
pins has differed on previous boards due to different chip configura-
tions). Shields designed for the new layout should work on any board
that uses the new pin locations. An additional pin (next to the IOREF
pin) is not being used at the moment, but enables new functionality to
be implemented in the future without needing to change the pin layout
again.

Discussion
If the power LED does not illuminate when the board is connected to your computer,
the board is probably not receiving power.

The flashing LED (connected to digital output pin 13) is being controlled by code
running on the board (new boards are preloaded with the Blink example sketch). If the
pin 13 LED is flashing, the sketch is running correctly, which means the chip on the
board is working. If the green power LED is on but the pin 13 LED is not flashing, it
could be that the factory code is not on the chip; follow the instructions in
Recipe 1.3 to load the Blink sketch onto the board to verify that the board is working.
If you are not using a standard board, it may not have a built-in LED on pin 13, so
check the documentation for details of your board. The Leonardo board fades the LED
up and down (it looks like the LED is “breathing”) to show that the board is working.

Figure 1-5. Leonardo Board
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See Also
Online guides for getting started with Arduino are available at http://arduino.cc/en/
Guide/Windows for Windows, http://arduino.cc/en/Guide/MacOSX for Mac OS X, and
http://www.arduino.cc/playground/Learning/Linux for Linux.

A troubleshooting guide can be found at http://arduino.cc/en/Guide/Troubleshooting.

1.3  Using the Integrated Development Environment (IDE) to
Prepare an Arduino Sketch
Problem
You want to get a sketch and prepare it for uploading to the board.

Solution
Use the Arduino IDE to create, open, and modify sketches that define what the board
will do. You can use buttons along the top of the IDE to perform these actions (shown
in Figure 1-6), or you can use the menus or keyboard shortcuts (shown in Figure 1-7).

The Sketch Editor area is where you view and edit code for a sketch. It supports com-
mon text-editing keys such as Ctrl-F (⌘+F on a Mac) for find, Ctrl-Z (⌘+Z on a Mac)
for undo, Ctrl-C (⌘+C on a Mac) to copy highlighted text, and Ctrl-V (⌘+V on a Mac)
to paste highlighted text.

Figure 1-7 shows how to load the Blink sketch (the sketch that comes preloaded on a
new Arduino board).

After you’ve started the IDE, go to the File→Examples menu and select 1. Basics→Blink,
as shown in Figure 1-7. The code for blinking the built-in LED will be displayed in the
Sketch Editor window (refer to Figure 1-6).

Before the code can be sent to the board, it needs to be converted into instructions that
can be read and executed by the Arduino controller chip; this is called compiling. To
do this, click the compile button (the top-left button with a tick inside), or select
Sketch→Verify/Compile (Ctrl-R; ⌘+R on a Mac).

You should see a message that reads “Compiling sketch...” and a progress bar in the
message area below the text-editing window. After a second or two, a message that
reads “Done Compiling” will appear. The black console area will contain the following
additional message:

Binary sketch size: 1026 bytes (of a 32256 byte maximum)

The exact message may differ depending on your board and Arduino version; it is telling
you the size of the sketch and the maximum size that your board can accept.
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Discussion
Source code for Arduino is called a sketch. The process that takes a sketch and converts
it into a form that will work on the board is called compilation. The IDE uses a number
of command-line tools behind the scenes to compile a sketch. For more information
on this, see Recipe 17.1.

The final message telling you the size of the sketch indicates how much program space
is needed to store the controller instructions on the board. If the size of the compiled

Figure 1-6. Arduino IDE
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sketch is greater than the available memory on the board, the following error message
is displayed:

Sketch too big; see http://www.arduino.cc/en/Guide/Troubleshooting#size
 for tips on reducing it.

If this happens, you need to make your sketch smaller to be able to put it on the board,
or get a board with higher capacity.

If there are errors in the code, the compiler will print one or more error messages in the
console window. These messages can help identify the error—see Appendix D on soft-
ware errors for troubleshooting tips.

To prevent accidental overwriting of the examples, the Arduino IDE
does not allow you to save changes to the provided example sketches.
You must rename them using the Save As menu option. You can save
sketches you write yourself with the Save button (see Recipe 1.5).

As you develop and modify a sketch, you should also consider using the File→Save As
menu option and using a different name or version number regularly so that as you
implement each bit, you can go back to an older version if you need to.

Figure 1-7. IDE menu (selecting the Blink example sketch)
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Code uploaded onto the board cannot be downloaded back onto your
computer. Make sure you save your sketch code on your computer. You
cannot save changes back to the example files; you need to use Save As
and give the changed file another name.

See Also
Recipe 1.5 shows an example sketch. Appendix D has tips on troubleshooting software
problems.

1.4  Uploading and Running the Blink Sketch
Problem
You want to transfer your compiled sketch to the Arduino board and see it working.

Solution
Connect your Arduino board to your computer using the USB cable. Load the Blink
sketch into the IDE as described in Recipe 1.3.

Next, select Tools→Board from the drop-down menu and select the name of the board
you have connected (if it is the standard Uno board, it is probably the first entry in the
board list).

Now select Tools→Serial Port. You will get a drop-down list of available serial ports on
your computer. Each machine will have a different combination of serial ports, de-
pending on what other devices you have used with your computer.

On Windows, they will be listed as numbered COM entries. If there is only one entry,
select it. If there are multiple entries, your board will probably be the last entry.

On the Mac, your board will be listed twice if it is an Uno board:

/dev/tty.usbmodem-XXXXXXX
/dev/cu.usbmodem-XXXXXXX

If you have an older board, it will be listed as follows:

/dev/tty.usbserial-XXXXXXX
/dev/cu.usbserial-XXXXXXX

Each board will have different values for XXXXXXX. Select either entry.

Click on the upload button (in Figure 1-6, it’s the second button from the left), or
choose File→Upload to I/O board (Ctrl-U, ⌘+U on a Mac).

The software will compile the code, as in Recipe 1.3. After the software is compiled, it
is uploaded to the board. If you look at your board, you will see the LED stop flashing,
and two lights (labeled as Serial LEDs in Figure 1-4) just below the previously flashing
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LED should flicker for a couple of seconds as the code uploads. The original light should
then start flashing again as the code runs.

Discussion
For the IDE to send the compiled code to the board, the board needs to be plugged in
to the computer, and you need to tell the IDE which board and serial port you are using.

When an upload starts, whatever sketch is running on the board is stopped (if you were
running the Blink sketch, the LED will stop flashing). The new sketch is uploaded to
the board, replacing the previous sketch. The new sketch will start running when the
upload has successfully completed.

Older Arduino boards and some compatibles do not automatically in-
terrupt the running sketch to initiate upload. In this case, you need to
press the Reset button on the board just after the software reports that
it is done compiling (when you see the message about the size of the
sketch). It may take a few attempts to get the timing right between the
end of the compilation and pressing the Reset button.

The IDE will display an error message if the upload is not successful. Problems are
usually due to the wrong board or serial port being selected or the board not being
plugged in. The currently selected board and serial port are displayed in the status bar
at the bottom of the Arduino window

If you have trouble identifying the correct port on Windows, try unplugging the board
and then selecting Tools→Serial Port to see which COM port is no longer on the display
list. Another approach is to select the ports, one by one, until you see the lights on the
board flicker to indicate that the code is uploading.

See Also
The Arduino troubleshooting page: http://www.arduino.cc/en/Guide/Troubleshooting.

1.5  Creating and Saving a Sketch
Problem
You want to create a sketch and save it to your computer.

Solution
To open an editor window ready for a new sketch, launch the IDE (see Recipe 1.3), go
to the File menu, and select New. Paste the following code into the Sketch Editor win-
dow (it’s similar to the Blink sketch, but the blinks last twice as long):
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const int ledPin =  13;    // LED connected to digital pin 13

void setup()
{
  pinMode(ledPin, OUTPUT);
}

void loop()
{
  digitalWrite(ledPin, HIGH);   // set the LED on
  delay(2000);                  // wait for two seconds
  digitalWrite(ledPin, LOW);    // set the LED off
  delay(2000);                  // wait for two seconds
}

Compile the code by clicking the compile button (the top-left button with a triangle
inside), or select Sketch→Verify/Compile (see Recipe 1.3).

Upload the code by clicking on the upload button, or choose File→Upload to I/O board
(see Recipe 1.4). After uploading, the LED should blink, with each flash lasting two
seconds.

You can save this sketch to your computer by clicking the Save button, or select
File→Save.

You can save the sketch using a new name by selecting the Save As menu option. A
dialog box will open where you can enter the filename.

Discussion
When you save a file in the IDE, a standard dialog box for the operating system will
open. It suggests that you save the sketch to a folder called Arduino in your My Docu-
ments folder (or your Documents folder on a Mac). You can replace the default sketch
name with a meaningful name that reflects the purpose of your sketch. Click Save to
save the file.

The default name is the word sketch followed by the current date. Se-
quential letters starting from a are used to distinguish sketches created
on the same day. Replacing the default name with something meaning-
ful helps you to identify the purpose of a sketch when you come back
to it later.

If you use characters that the IDE does not allow (e.g., the space character), the IDE
will automatically replace these with valid characters.

Arduino sketches are saved as plain text files with the extension .ino. Older versions of
the IDE used the .pde extension, also used by Processing. They are automatically saved
in a folder with the same name as the sketch.

1.5  Creating and Saving a Sketch | 15



You can save your sketches to any folder on your computer, but if you use the default
folder (the Arduino folder in your Documents folder) your sketches will automatically
appear in the Sketchbook menu of the Arduino software and be easier to locate.

If you have edited one of the examples from the Arduino download, you
will not be able to save the changed file using the same filename. This
preserves the standard examples intact. If you want to save a modified
example, you will need to select another location for the sketch.

After you have made changes, you will see a dialog box asking if you want to save the
sketch when a sketch is closed.

The § symbol following the name of the sketch in the top bar of the IDE
window indicates that the sketch code has changes that have not yet
been saved on the computer. This symbol is removed when you save the
sketch.

The Arduino software does not provide any kind of version control, so if you want to
be able to revert to older versions of a sketch, you can use Save As regularly and give
each revision of the sketch a slightly different name.

Frequent compiling as you modify or add code is a good way to check for errors as you
write your code. It will be easier to find and fix any errors because they will usually be
associated with what you have just written.

Once a sketch has been uploaded onto the board there is no way to
download it back to your computer. Make sure you save any changes
to your sketches that you want to keep.

If you try and save a sketch file that is not in a folder with the same name as the sketch,
the IDE will inform you that this can’t be opened as is and suggest you click OK to
create the folder for the sketch with the same name.

Sketches must be located in a folder with the same name as the sketch.
The IDE will create the folder automatically when you save a new sketch.

Sketches made with older versions of Arduino software have a different
file extension (.pde). The IDE will open them, when you save the sketch
it will create a file with the new extension (.ino). Code written for early
versions of the IDE may not be able to compile in version 1.0. Most of
the changes to get old code running are easy to do. See Appendix H for
more details.
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See Also
The code in this recipe and throughout this book use the const int expression to
provide meaningful names (ledPin) for constants instead of numbers (13). See
Recipe 17.5 for more on the use of constants.

1.6  Using Arduino
Problem
You want to get started with a project that is easy to build and fun to use.

Solution
This recipe provides a taste of some of the techniques that are covered in detail in later
chapters.

The sketch is based on the LED blinking code from the previous recipe, but instead of
using a fixed delay, the rate is determined by a light-sensitive sensor called a light de-
pendent resistor or LDR (see Recipe 6.2). Wire the LDR as shown in Figure 1-8.

Figure 1-8. Arduino with light dependent resistor

If you are not familiar with building a circuit from a schematic, see
Appendix B for step-by-step illustrations on how to make this circuit on
a breadboard.
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The following sketch reads the light level of an LDR connected to analog pin 0. The
light level striking the LDR will change the blink rate of the internal LED connected to
pin 13:

const int ledPin =  13;     // LED connected to digital pin 13
const int sensorPin = 0;    // connect sensor to analog input 0

void setup()
{
  pinMode(ledPin, OUTPUT);  // enable output on the led pin
}

void loop()
{
  int rate = analogRead(sensorPin);    // read the analog input
  digitalWrite(ledPin, HIGH);   // set the LED on
  delay(rate);                  // wait duration dependent on light level
  digitalWrite(ledPin, LOW);    // set the LED off
  delay(rate);
}

Discussion
The value of the 4.7K resistor is not critical. Anything from 1K to 10K can be used. The
light level on the LDR will change the voltage level on analog pin 0. The analogRead
command (see Chapter 6) provides a value that ranges from around 200 when the LDR
is dark to 800 or so when it is very bright. This value determines the duration of the
LED on and off times, so the blink time increases with light intensity.

You can scale the blink rate by using the Arduino map function as follows:

const int ledPin =  13;     // LED connected to digital pin 13
const int sensorPin = 0;    // connect sensor to analog input 0

// the next two lines set the min and max delay between blinks
const int minDuration = 100;  // minimum wait between blinks
const int maxDuration = 1000;  // maximum wait between blinks

void setup()
{
  pinMode(ledPin, OUTPUT);  // enable output on the led pin
}

void loop()
{
  int rate = analogRead(sensorPin);    // read the analog input
  // the next line scales the blink rate between the min and max values
  rate = map(rate, 200,800,minDuration, maxDuration); // convert to blink rate
  rate = constrain(rate, minDuration,maxDuration);    // constrain the value       
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  digitalWrite(ledPin, HIGH);   // set the LED on
  delay(rate);                  // wait duration dependent on light level
  digitalWrite(ledPin, LOW);    // set the LED off
  delay(rate);
}

Recipe 5.7 provides more details on using the map function to scale values. Recipe 3.5
has details on using the constrain function to ensure values do not exceed a given range.

If you want to view the value of the rate variable on your computer, you can print this
to the Arduino Serial Monitor as shown in the revised loop code that follows. The
sketch will display the blink rate in the Serial Monitor. You open the Serial Monitor
window in the Arduino IDE by clicking on the icon on the right of the top bar (see
Chapter 4 for more on using the Serial Monitor):

const int ledPin =  13;     // LED connected to digital pin 13
const int sensorPin = 0;    // connect sensor to analog input 0

// the next two lines set the min and max delay between blinks
const int minDuration = 100;  // minimum wait between blinks
const int maxDuration = 1000;  // maximum wait between blinks

void setup()
{
  pinMode(ledPin, OUTPUT);  // enable output on the led pin
  Serial.begin(9600);       // initialize Serial
}

void loop()
{
  int rate = analogRead(sensorPin);    // read the analog input
  // the next line scales the blink rate between the min and max values
  rate = map(rate, 200,800,minDuration, maxDuration); // convert to blink rate
  rate = constrain(rate, minDuration,maxDuration);    // constrain the value       
  
  Serial.println(rate);         // print rate to serial monitor
  digitalWrite(ledPin, HIGH);   // set the LED on
  delay(rate);                  // wait duration dependent on light level
  digitalWrite(ledPin, LOW);    // set the LED off
  delay(rate);
}

You can use the LDR to control the pitch of a sound by connecting a small speaker to
the pin, as shown in Figure 1-9.
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Figure 1-9. Connections for a speaker with the LDR circuit

You will need to increase the on/off rate on the pin to a frequency in the audio spectrum.
This is achieved, as shown in the following code, by decreasing the min and max
durations:

const int outputPin = 9;    // Speaker connected to digital pin 9
const int sensorPin = 0;    // connect sensor to analog input 0

const int minDuration = 1;   // 1ms on, 1ms off (500 Hz)
const int maxDuration = 10;  // 10ms on, 10ms off (50 hz)

void setup()
{
  pinMode(outputPin, OUTPUT);  // enable output on the led pin
}

void loop()
{
  int sensorReading = analogRead(sensorPin);    // read the analog input
  int rate = map(sensorReading, 200,800,minDuration, maxDuration);
  rate = constrain(rate, minDuration,maxDuration);    // constrain the value
  
  digitalWrite(outputPin, HIGH);   // set the LED on
  delay(rate);                     // wait duration dependent on light level
  digitalWrite(outputPin, LOW);    // set the LED off
  delay(rate);
}
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See Also
See Recipe 3.5 for details on using the constrain function.

See Recipe 5.7 for a discussion on the map function.

If you are interested in creating sounds, see Chapter 9 for a full discussion on audio
output with Arduino.
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CHAPTER 2

Making the Sketch Do Your Bidding

2.0  Introduction
Though much of an Arduino project will involve integrating the Arduino board with
supporting hardware, you need to be able to tell the board what to do with the rest of
your project. This chapter introduces core elements of Arduino programming, shows
nonprogrammers how to use common language constructs, and provides an overview
of the language syntax for readers who are not familiar with C or C++, the language
that Arduino uses.

Since making the examples interesting requires making Arduino do something, the
recipes use physical capabilities of the board that are explained in detail in later chap-
ters. If any of the code in this chapter is not clear, feel free to jump forward, particularly
to Chapter 4 for more on serial output and Chapter 5 for more on using digital and
analog pins. You don’t need to understand all the code in the examples, though, to see
how to perform the specific capabilities that are the focus of the recipes. Here are some
of the more common functions used in the examples that are covered in the next few
chapters:

Serial.println(value);
Prints the value to the Arduino IDE’s Serial Monitor so you can view Arduino’s
output on your computer; see Recipe 4.1.

pinMode(pin, mode);
Configures a digital pin to read (input) or write (output) a digital value; see the
introduction to Chapter 5.

digitalRead(pin);
Reads a digital value (HIGH or LOW) on a pin set for input; see Recipe 5.1.

digitalWrite(pin, value);
Writes the digital value (HIGH or LOW) to a pin set for output; see Recipe 5.1.
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2.1  Structuring an Arduino Program
Problem
You are new to programming and want to understand the building blocks of an Arduino
program.

Solution
Programs for Arduino are usually referred to as sketches; the first users were artists and
designers and sketch highlights the quick and easy way to have an idea realized. The
terms sketch and program are interchangeable. Sketches contain code—the instructions
the board will carry out. Code that needs to run only once (such as to set up the board
for your application) must be placed in the setup function. Code to be run continuously
after the initial setup has finished goes into the loop function. Here is a typical sketch:

const int ledPin =  13;    // LED connected to digital pin 13

 // The setup() method runs once, when the sketch starts
 void setup()
 {
   pinMode(ledPin, OUTPUT);      // initialize the digital pin as an output
 }

 // the loop() method runs over and over again,
 void loop()
 {
   digitalWrite(ledPin, HIGH);   // turn the LED on
   delay(1000);                  // wait a second
   digitalWrite(ledPin, LOW);    // turn the LED off
   delay(1000);                  // wait a second
 }

When the Arduino IDE finishes uploading the code, and every time you power on the
board after you’ve uploaded this code, it starts at the top of the sketch and carries out
the instructions sequentially. It runs the code in setup once and then goes through the
code in loop. When it gets to the end of loop (marked by the closing bracket, }) it goes
back to the beginning of loop.

Discussion
This example continuously flashes an LED by writing HIGH and LOW outputs to a pin.
See Chapter 5 to learn more about using Arduino pins. When the sketch begins, the
code in setup sets the pin mode (so it’s capable of lighting an LED). After the code in
setup is completed, the code in loop is repeatedly called (to flash the LED) for as long
as the Arduino board is powered on.
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You don’t need to know this to write Arduino sketches, but experienced C/C++ pro-
grammers may wonder where the expected main() entry point function has gone. It’s
there, but it’s hidden under the covers by the Arduino build environment. The build
process creates an intermediate file that includes the sketch code and the following
additional statements:

int main(void)
{
    init();

    setup();

    for (;;)
        loop();

    return 0;
}

The first thing that happens is a call to an init() function that initializes the Arduino
hardware. Next, your sketch’s setup() function is called. Finally, your loop() function
is called over and over. Because the for loop never terminates, the return statement is
never executed.

See Also
Recipe 1.4 explains how to upload a sketch to the Arduino board.

Chapter 17 and http://www.arduino.cc/en/Hacking/BuildProcess provide more on the
build process.

2.2  Using Simple Primitive Types (Variables)
Problem
Arduino has different types of variables to efficiently represent values. You want to
know how to select and use these Arduino data types.

Solution
Although the int (short for integer, a 16-bit value in Arduino) data type is the most
common choice for the numeric values encountered in Arduino applications, you can
use Table 2-1 to determine the data type that fits the range of values your application
expects.
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Table 2-1. Arduino data types

Numeric types Bytes Range Use

int 2 –32768 to 32767 Represents positive and negative integer values.

unsigned int 2 0 to 65535 Represents only positive values; otherwise, similar to int.

long 4 –2147483648 to
2147483647

Represents a very large range of positive and negative values.

unsigned
long

4 4294967295 Represents a very large range of positive values.

float 4 3.4028235E+38 to –
3.4028235E+38

Represents numbers with fractions; use to approximate real-
world measurements.

double 4 Same as float In Arduino, double is just another name for float.

boolean 1 false (0) or true (1) Represents true and false values.

char 1 –128 to 127 Represents a single character. Can also represent a signed value
between –128 and 127.

byte 1 0 to 255 Similar to char, but for unsigned values.

Other types Use

String Represents arrays of chars (characters) typically used to contain text.

void Used only in function declarations where no value is returned.

Discussion
Except in situations where maximum performance or memory efficiency is required,
variables declared using int will be suitable for numeric values if the values do not
exceed the range (shown in the first row in Table 2-1) and if you don’t need to work
with fractional values. Most of the official Arduino example code declares numeric
variables as int. But sometimes you do need to choose a type that specifically suits your
application.

Sometimes you need negative numbers and sometimes you don’t, so numeric types
come in two varieties: signed and unsigned. unsigned values are always positive. Vari-
ables without the keyword unsigned in front are signed so that they can represent neg-
ative and positive values. One reason to use unsigned values is when the range of
signed values will not fit the range of the variable (an unsigned variable has twice the
capacity of a signed variable). Another reason programmers choose to use unsigned
types is to clearly indicate to people reading the code that the value expected will never
be a negative number.

boolean types have two possible values: true or false. They are commonly used for
things like checking the state of a switch (if it’s pressed or not). You can also use HIGH
and LOW as equivalents to true and false where this makes more sense; digital
Write(pin, HIGH) is a more expressive way to turn on an LED than digitalWrite(pin,
true) or digitalWrite(pin,1), although all of these are treated identically when the
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sketch actually runs, and you are likely to come across all of these forms in code posted
on the Web.

See Also
The Arduino reference at http://www.arduino.cc/en/Reference/HomePage provides de-
tails on data types.

2.3  Using Floating-Point Numbers
Problem
Floating-point numbers are used for values expressed with decimal points (this is the
way to represent fractional values). You want to calculate and compare these values in
your sketch.

Solution
The following code shows how to declare floating-point variables, illustrates problems
you can encounter when comparing floating-point values, and demonstrates how to
overcome them:

/*
 * Floating-point example
 * This sketch initialized a float value to 1.1
 * It repeatedly reduces the value by 0.1 until the value is 0
 */

float  value = 1.1;

void setup()
{
  Serial.begin(9600);
}

void loop()
{
  value = value - 0.1;   // reduce value by 0.1 each time through the loop
  if( value == 0)
     Serial.println("The value is exactly zero");
  else if(almostEqual(value, 0))
  {
    Serial.print("The value ");
    Serial.print(value,7); // print to 7 decimal places
    Serial.println(" is almost equal to zero");
  }
  else
    Serial.println(value);

  delay(100);
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}
      
// returns true if the difference between a and b is small
// set value of DELTA to the maximum difference considered to be equal
boolean almostEqual(float a, float b)    
{
  const float DELTA = .00001; // max difference to be almost equal 
  if (a == 0) return fabs(b) <= DELTA;
  if (b == 0) return fabs(a) <= DELTA;
  return fabs((a - b) / max(fabs(a), fabs(b))) <= DELTA ;
}

Discussion
Floating-point math is not exact, and values returned can have a small approximation
error. The error occurs because floating-point values cover a huge range, so the internal
representation of the value can only hold an approximation. Because of this, you need
to test if the values are within a range of tolerance rather than exactly equal.

The Serial Monitor output from this sketch is as follows:

1.00
0.90
0.80
0.70
0.60
0.50
0.40
0.30
0.20
0.10
The value -0.0000001 is almost equal to zero
-0.10
-0.20

The output continues to produce negative numbers.

You may expect the code to print "The value is exactly zero" after value is 0.1 and
then 0.1 is subtracted from this. But value never equals exactly zero; it gets very close,
but that is not good enough to pass the test: if (value == 0). This is because the only
memory-efficient way that floating-point numbers can contain the huge range in values
they can represent is by storing an approximation of the number.

The solution to this is to check if a variable is close to the desired value, as shown in
this recipe’s Solution.

The almostEqual function tests if the variable value is within 0.00001 of the desired
target and returns true if so. The acceptable range is set with the constant DELTA, you
can change this to smaller or larger values as required. The function named fabs (short
for floating-point absolute value) returns the absolute value of a floating-point variable
and this is used to test the difference between the given parameters.
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Floating point approximates numbers because it only uses 32 bits to
hold all values within a huge range. Eight bits are used for the decimal
multiplier (the exponent), and that leaves 24 bits for the sign and
value—only enough for seven significant decimal digits.

Although float and double are exactly the same on Arduino, doubles do
have a higher precision on many other platforms. If you are importing
code that uses float and double from another platform, check that there
is sufficient precision for your application.

See Also
The Arduino reference for float: http://www.arduino.cc/en/Reference/Float.

2.4  Working with Groups of Values
Problem
You want to create and use a group of values (called arrays). The arrays may be a simple
list or they could have two or more dimensions. You want to know how to determine
the size of the array and how to access the elements in the array.

Solution
This sketch creates two arrays: an array of integers for pins connected to switches and
an array of pins connected to LEDs, as shown in Figure 2-1:

/*
 array sketch
 an array of switches controls an array of LEDs
 see Chapter 5 for more on using switches
 see Chapter 7 for information on LEDs
 */

int inputPins[] = {2,3,4,5};  // create an array of pins for switch inputs

int ledPins[] = {10,11,12,13};  // create array of output pins for LEDs

void setup()
{
  for(int index = 0; index < 4; index++)
  {
    pinMode(ledPins[index], OUTPUT);         // declare LED as output
    pinMode(inputPins[index], INPUT);        // declare pushbutton as input
    
    digitalWrite(inputPins[index],HIGH);     // enable pull-up resistors
    // (see Recipe 5.2)
  }
}
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void loop(){
  for(int index = 0; index < 4; index++)
  {
    int val = digitalRead(inputPins[index]);  // read input value
    if (val == LOW)                           // check if the switch is pressed
    {
      digitalWrite(ledPins[index], HIGH); // turn LED on if switch is pressed
    }
    else
    {
      digitalWrite(ledPins[index], LOW);  // turn LED off
    }
  }
}

Figure 2-1. Connections for LEDs and switches
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Discussion
Arrays are collections of consecutive variables of the same type. Each variable in the
collection is called an element. The number of elements is called the size of the array.

The Solution demonstrates a common use of arrays in Arduino code: storing a collec-
tion of pins. Here the pins connect to switches and LEDs (a topic covered in more detail
in Chapter 5). The important parts of this example are the declaration of the array and
access to the array elements.

The following line of code declares (creates) an array of integers with four elements and
initializes each element. The first element is set equal to 2, the second to 3, and so on:

int inputPins[] = {2,3,4,5};

If you don’t initialize values when you declare an array (for example, when the values
will only be available when the sketch is running), you must change each element in-
dividually. You can declare the array as follows:

int inputPins[4];

This declares an array of four elements with the initial value of each element set to zero.
The number within the square brackets ([]) is the size, and this sets the number of
elements. This array has a size of four and can hold, at most, four integer values. The
size can be omitted if array declaration contains initializers (as shown in the first ex-
ample) because the compiler figures out how big to make the array by counting the
number of initializers.

The first element of the array is element[0]:

int firstElement = inputPins[0];  // this is the first element

inputPins[0] = 2; // set the value of this element equal to 2

The last element is one less than the size, so in the preceding example, with a size of
four, the last element is element 3:

int lastElement = inputPins[3]; // this is the last element

It may seem odd that an array with a size of four has the last element accessed using
array[3], but because the first element is array[0], the four elements are:

inputPins[0],inputPins[1],inputPins[2],inputPins[3]

In the previous sketch, the four elements are accessed using a for loop:

for(int index = 0; index < 4; index++)
{
    //get the pin number by accessing each element in the pin arrays
    pinMode(ledPins[index], OUTPUT);         // declare LED as output
    pinMode(inputPins[index], INPUT);        // declare pushbutton as input
}

This loop will step through the variable index with values starting at 0 and ending at
3. It is a common mistake to accidentally access an element that is beyond the actual
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size of the array. This is a bug that can have many different symptoms and care must
be taken to avoid it. One way to keep your loops under control is to set the size of an
array by using a constant as follows:

const int PIN_COUNT = 4;  // define a constant for the number of elements
int inputPins[PIN_COUNT] = {2,3,4,5};

  for(int index = 0; index < PIN_COUNT; index++)
    pinMode(inputPins[index], INPUT);

The compiler will not report an error if you accidentally try to store or
read beyond the size of the array. You must be careful that you only
access elements that are within the bounds you have set. Using a con-
stant to set the size of an array and in code referring to its elements helps
your code stay within the bounds of the array.

Another use of arrays is to hold a string of text characters. In Arduino code, these are
called character strings (strings for short). A character string consists of one or more
characters, followed by the null character (the value 0) to indicate the end of the string.

The null at the end of a character string is not the same as the character
0. The null has an ASCII value of 0, whereas 0 has an ASCII value of 48.

Methods to use strings are covered in Recipes 2.5 and 2.6.

See Also
Recipe 5.2; Recipe 7.1

2.5  Using Arduino String Functionality
Problem
You want to manipulate text. You need to copy it, add bits together, and determine
the number of characters.

Solution
The previous recipe mentioned how arrays of characters can be used to store text: these
character arrays are usually called strings. Arduino has a capability called String that
adds rich functionality for storing and manipulating text.
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The word String with an uppercase S refers to the Arduino text capability
provided by the Arduino String library. The word string with a lowercase
s refers to the group of characters rather than the Arduino String
functionality.

This recipe demonstrates how to use Arduino Strings.

The String capability was introduced in version 0019 alpha (older than
1.0) of Arduino. If you are using an older version, you can use the Text-
String library; see the link at the end of this recipe.

Load the following sketch onto your board, and open the Serial Monitor to view the 
results:

/*
  Basic_Strings sketch
 */

String text1 = "This string";
String text2 = " has more text";
String text3;  // to be assigned within the sketch

void setup()
{
  Serial.begin(9600);

  Serial.print( text1);
  Serial.print(" is ");
  Serial.print(text1.length());
  Serial.println(" characters long.");

  Serial.print("text2 is ");
  Serial.print(text2.length());
  Serial.println(" characters long.");

  text1.concat(text2);
  Serial.println("text1 now contains: ");
  Serial.println(text1);
}

void loop()
{
}

Discussion
This sketch creates three variables of type String, called text1, text2, and text3. Vari-
ables of type String have built-in capabilities for manipulating text. The statement
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text1.length() returns (provides the value of) the length (number of characters) in the
string text1.

text1.concat(text2) combines the contents of strings; in this case, it appends the con-
tents of text2 to the end of text1 (concat is short for concatenate).

The Serial Monitor will display the following:

This string is 11 characters long.
text2 is 14 characters long.
text1 now contains:
This string has more text

Another way to combine strings is to use the string addition operator. Add these two
lines to the end of the setup code:

  text3 = text1 + " and more";
  Serial.println(text3);

The new code will result in the Serial Monitor adding the following line to the end of
the display:

This string has more text and more

You can use the indexOf and lastIndexOf functions to find an instance of a particular
character in a string.

Because the String class is a recent addition to Arduino, you will come
across a lot of code that uses arrays of characters rather than the
String type. See Recipe 2.6 for more on using arrays of characters
without the help of the Arduino String functionality.

If you see a line such as the following:

char oldString[] = "this is a character array";

the code is using C-style character arrays (see Recipe 2.6). If the declaration looks like
this:

String newString = "this is a string object";

the code uses Arduino Strings. To convert a C-style character array to an Arduino
String, just assign the contents of the array to the String object:

char oldString[] = "I want this character array in a String object";
String newString = oldString;

To use any of the functions listed in Table 2-2, you need to invoke them upon an existing
string object, as in this example:

int len = myString.length();
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Table 2-2. Brief overview of Arduino String functions

charAt(n) Returns the nth character of the String

compareTo(S2) Compares the String to the given String S2

concat(S2) Returns a new String that is the combination of the String and S2

endsWith(S2) Returns true if the String ends with the characters of S2

equals(S2) Returns true if the String is an exact match for S2 (case-sensitive)

equalsIgnoreCase(S2) Same as equals but is not case-sensitive

getBytes(buffer,len) Copies len(gth) characters into the supplied byte buffer

indexOf(S) Returns the index of the supplied String (or character) or –1 if not found

lastIndexOf(S) Same as indexOf but starts from the end of the String

length() Returns the number of characters in the String

replace(A,B) Replaces all instances of String (or character) A with B

setCharAt(index,c) Stores the character c in the String at the given index

startsWith(S2) Returns true if the String starts with the characters of S2

substring(index) Returns a String with the characters starting from index to the end of the String

substring(index,to) Same as above, but the substring ends at the character location before the ‘to’ position

toCharArray(buffer,len) Copies up to len characters of the String to the supplied buffer

toInt() Returns the integer value of the numeric digits in the String

toLowerCase() Returns a String with all characters converted to lowercase

toUpperCase() Returns a String with all characters converted to uppercase

trim() Returns a String with all leading and trailing whitespace removed

See the Arduino reference pages for more about the usage and variants for these
functions.

Choosing between Arduino Strings and C character arrays

Arduino’s built-in String datatype is easier to use than C character arrays, but this is
achieved through complex code in the String library, which makes more demands on
your Arduino, and is, by nature, more prone to problems.

The String datatype is so flexible because it makes use of dynamic memory allocation.
That is, when you create or modify a String, Arduino requests a new region of memory
from the C library, and when you’re done using a String, Arduino needs to release that
memory. This usually works smoothly, but in practice there are many cracks through
which memory can leak. Bugs in the String library can result in some or all of the
memory not being returned properly. When this happens, the memory available to
Arduino will slowly decrease (until you reboot the Arduino). And even if there were no
memory leaks, it’s complicated to write code to check if a String request failed due to
insufficient memory (the String functions mimic those in Processing, but unlike that
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platform, Arduino does not have runtime error exception handling). Running out of
dynamic memory is a bug that can be very difficult to track down because the sketch
can run without problems for days or weeks before it starts misbehaving through in-
sufficient memory.

If you use C character arrays, you are in control of memory usage: you’re allocating a
fixed (static) amount of memory at compile time so you don’t get memory leaks. Your
Arduino sketch will have the same amount of memory available to it all the time it’s
running. And if you do try to allocate more memory than available, finding the cause
is easier because there are tools that tell you how much static memory you have allo-
cated (see the reference to avr-objdump in Recipe 17.1).

However, with C character arrays, it’s easier for you to have another problem: C will
not prevent you from modifying memory beyond the bounds of the array. So if you
allocate an array as myString[4], and assign myString[4] = 'A' (remember,
myString[3] is the end of the array), nothing will stop you from doing this. But who
knows what piece of memory myString[4] refers to? And who knows whether assigning
'A' to that memory location will cause you a problem? Most likely, it will cause your
sketch to misbehave.

So, Arduino’s built-in String library, by virtue of using dynamic memory, runs the risk
of eating up your available memory. C’s character arrays require care on your part to
ensure that you do not exceed the bounds of the arrays you use. So use Arduino’s built-
in String library if you need rich text handling capability and you won’t be creating and
modifying Strings over and over again. If you need to create and modify them in a loop
that is constantly repeating, you’re better off allocating a large C character array and
writing your code carefully so you don’t write past the bounds of that array.

Another instance where you may prefer C character arrays over Arduino Strings is in
large sketches that need most of the available RAM or flash. The Arduino String
ToInt example code uses almost 2 KB more flash than equivalent code using a C char-
acter array and atoi to convert to an int. The Arduino String version also requires a
little more RAM to store allocation information in addition to the actual string.

If you do suspect that the String library, or any other library that makes use of dynam-
ically allocated memory, might be leaking memory, you can determine how much
memory is free at any given time; see Recipe 17.2. Check the amount of RAM when
your sketch starts, and monitor it to see whether it’s decreasing over time. If you suspect
a problem with the String library, search the list of open bugs (http://code.google.com/
p/arduino/issues/list) for “String.”

See Also
The Arduino distribution provides String example sketches (File→Examples→Strings).

The String reference page can be found at http://arduino.cc/en/Reference/StringObject.
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Tutorials for the new String library are available at http://arduino.cc/en/Tutorial/Home
Page, and a tutorial for the original String library (only needed if you are using a version
of Arduino older than 0019 alpha) is available at http://www.arduino.cc/en/Tutorial/
TextString.

2.6  Using C Character Strings
Problem
You want to understand how to use raw character strings: you want to know how to
create a string, find its length, and compare, copy, or append strings. The core C lan-
guage does not support the Arduino-style String capability, so you want to understand
code from other platforms written to operate with primitive character arrays.

Solution
Arrays of characters are sometimes called character strings (or simply strings for short).
Recipe 2.4 describes Arduino arrays in general. This recipe describes functions that
operate on character strings.

You declare strings like this:

char stringA[8]; // declare a string of up to 7 chars plus terminating null
char stringB[8]  = "Arduino"; // as above and init(ialize) the string to "Arduino"
char stringC[16] = "Arduino"; // as above, but string has room to grow
char stringD[ ]  = "Arduino"; // the compiler inits the string and calculates size

Use strlen (short for string length) to determine the number of characters before the
terminating null:

int length = strlen(string);  // return the number of characters in the string

length will be 0 for stringA and 7 for the other strings shown in the preceding code.
The null that indicates the end of the string is not counted by strlen.

Use strcpy (short for string copy) to copy one string to another:

strcpy(destination, source);   // copy string source to destination

Use strncpy to limit the number of characters to copy (useful to prevent writing more
characters than the destination string can hold). You can see this used in Recipe 2.7:

// copy up to 6 characters from source to destination
strncpy(destination, source, 6);

Use strcat (short for string concatenate) to append one string to the end of another:

// append source string to the end of the destination string
strcat(destination, source);
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Always make sure there is enough room in the destination when copying
or concatenating strings. Don’t forget to allow room for the terminating
null.

Use strcmp (short for string compare) to compare two strings. You can see this used in
Recipe 2.7:

if(strcmp(str, "Arduino") == 0)
   // do something if the variable str is equal to "Arduino"

Discussion
Text is represented in the Arduino environment using an array of characters called
strings. A string consists of a number of characters followed by a null (the value 0). The
null is not displayed, but it is needed to indicate the end of the string to the software.

See Also
See one of the many online C/C++ reference pages, such as http://www.cplusplus.com/
reference/clibrary/cstring/ and http://www.cppreference.com/wiki/string/c/start.

2.7  Splitting Comma-Separated Text into Groups
Problem
You have a string that contains two or more pieces of data separated by commas (or
any other separator). You want to split the string so that you can use each individual
part.

Solution
This sketch prints the text found between each comma:

/*
 * SplitSplit sketch
 * split a comma-separated string
 */

String  text = "Peter,Paul,Mary";  // an example string
String  message = text; // holds text not yet split
int     commaPosition;  // the position of the next comma in the string

void setup()
{
  Serial.begin(9600);
  
  Serial.println(message);          // show the source string
  do
  {
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      commaPosition = message.indexOf(',');
      if(commaPosition != -1)
      {
          Serial.println( message.substring(0,commaPosition));
          message = message.substring(commaPosition+1, message.length());
      }
      else
      {  // here after the last comma is found
         if(message.length() > 0)
           Serial.println(message);  // if there is text after the last comma,
                                     // print it
      }
   }
   while(commaPosition >=0);
}

void loop()
{
}

The Serial Monitor will display the following:

Peter,Paul,Mary
Peter
Paul
Mary

Discussion
This sketch uses String functions to extract text from between commas. The following
code:

commaPosition = message.indexOf(',');

sets the variable commaPosition to the position of the first comma in the String named
message (it will be set to –1 if no comma is found). If there is a comma, the substring
function is used to print the text from the beginning of the string up to, but excluding,
the comma. The text that was printed, and its trailing comma, are removed from
message in this line:

message = message.substring(commaPosition+1, message.length());

substring returns a string starting from commaPosition+1 (the position just after the first
comma) up to the length of the message. This results in that message containing only
the text following the first comma. This is repeated until no more commas are found
(commaPosition will be equal to –1).

If you are an experienced programmer, you can also use the low-level functions that
are part of the standard C library. The following sketch has similar functionality to the
preceding one using Arduino strings:

/*
 * SplitSplit sketch
 * split a comma-separated string
 */
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const int  MAX_STRING_LEN = 20; // set this to the largest string
                                // you will process
                                
char stringList[] = "Peter,Paul,Mary"; // an example string

char stringBuffer[MAX_STRING_LEN+1]; // a static buffer for computation and output

void setup()
{
  Serial.begin(9600);
}

void loop()
{
  char *str;
  char *p;
  strncpy(stringBuffer, stringList, MAX_STRING_LEN); // copy source string
  Serial.println(stringBuffer);                      // show the source string
  
  for( str = strtok_r(stringBuffer, ",", &p);        // split using comma
       str;                                          // loop while str is not null
       str = strtok_r(NULL, ",", &p)                 // get subsequent tokens
     )
  {
    Serial.println(str);
  }
    delay(5000);
}

The core functionality comes from the function named strtok_r (the name of the ver-
sion of strtok that comes with the Arduino compiler). The first time you call
strtok_r, you pass it the string you want to tokenize (separate into individual values).
But strtok_r overwrites the characters in this string each time it finds a new token, so
it’s best to pass a copy of the string as shown in this example. Each call that follows
uses a NULL to tell the function that it should move on to the next token. In this example,
each token is printed to the serial port.

If your tokens consist only of numbers, see Recipe 4.5. This shows how to extract
numeric values separated by commas in a stream of serial characters.

See Also
See http://www.nongnu.org/avr-libc/user-manual/group__avr__string.html for more on
C string functions such as strtok_r and strcmp.

Recipe 2.5; online references to the C/C++ functions strtok_r and strcmp.
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2.8  Converting a Number to a String
Problem
You need to convert a number to a string, perhaps to show the number on an LCD or
other display.

Solution
The String variable will convert numbers to strings of characters automatically. You
can use literal values, or the contents of a variable. For example, the following code
will work:

String myNumber = 1234;

As will this:

int value = 127;
String myReadout = "The reading was ";
myReadout.concat(value);

Or this:

int value = 127;
String myReadout = "The reading was ";
myReadout += value;

Discussion
If you are converting a number to display as text on an LCD or serial device, the simplest
solution is to use the conversion capability built in to the LCD and Serial libraries (see
Recipe 4.2). But perhaps you are using a device that does not have this built-in support
(see Chapter 13) or you want to manipulate the number as a string in your sketch.

The Arduino String class automatically converts numerical values when they are as-
signed to a String variable. You can combine (concatenate) numeric values at the end
of a string using the concat function or the string + operator.

The + operator is used with number types as well as strings, but it be-
haves differently with each.

The following code results in number having a value of 13:

    int number = 12;
    number += 1;

With a String, as shown here:

    String textNumber = "12";
    textNumber += 1;
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textNumber is the text string "121".

Prior to the introduction of the String class, it was common to find Arduino code using
the itoa or ltoa function. The names come from “integer to ASCII” (itoa) and “long
to ASCII” (ltoa). The String version described earlier is easier to use, but the following
can be used if you prefer working with C character arrays as described in Recipe 2.6.

itoa or ltoa take three parameters: the value to convert, the buffer that will hold the
output string, and the number base (10 for a decimal number, 16 for hex, and 2 for
binary).

The following sketch illustrates how to convert numeric values using ltoa:

/*
 * NumberToString
 * Creates a string from a given number
 */

void setup()
{
  Serial.begin(9600);
}

char buffer[12];  // long data type has 11 characters (including the
                  // minus sign) and a terminating null
void loop()
{
  long value = 12345;
  ltoa(value, buffer, 10);
  Serial.print( value);
  Serial.print(" has  ");
  Serial.print(strlen(buffer));
  Serial.println(" digits");
  value = 123456789;
  ltoa(value, buffer, 10);
  Serial.print( value);
  Serial.print(" has  ");
  Serial.print(strlen(buffer));
  Serial.println(" digits");
  delay(1000);
}

Your buffer must be large enough to hold the maximum number of characters in the
string. For 16-bit base 10 (decimal) integers, that is seven characters (five digits, a pos-
sible minus sign, and a terminating 0 that always signifies the end of a string); 32-bit
long integers need 12 character buffers (10 digits, the minus sign, and the terminating
0). No warning is given if you exceed the buffer size; this is a bug that can cause all
kinds of strange symptoms, because the overflow will corrupt some other part of mem-
ory that may be used by your program. The easiest way to handle this is to always use
a 12-character buffer and always use ltoa because this will work on both 16-bit and
32-bit values.
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2.9  Converting a String to a Number
Problem
You need to convert a string to a number. Perhaps you have received a value as a string
over a communication link and you need to use this as an integer or floating-point value.

Solution
There are a number of ways to solve this. If the string is received as serial data, it can
be converted on the fly as each character is received. See Recipe 4.3 for an example of
how to do this using the serial port.

Another approach to converting text strings representing numbers is to use the C lan-
guage conversion function called atoi (for int variables) or atol (for long variables).

This code fragment terminates the incoming digits on any character that is not a digit
(or if the buffer is full). For this to work, though, you’ll need to enable the newline
option in the Serial Monitor or type some other terminating character:

/*
 * StringToNumber
 * Creates a number from a string
 */

const int ledPin = 13; // pin the LED is connected to

int   blinkDelay;     // blink rate determined by this variable
char strValue[6];     // must be big enough to hold all the digits and the
                      // 0 that terminates the string
int index = 0;        // the index into the array storing the received digits

void setup()
{
 Serial.begin(9600); 
 pinMode(ledPin,OUTPUT); // enable LED pin as output
}

void loop()
{
  if( Serial.available())
  {
    char ch = Serial.read();
    if(index < 5 && isDigit(ch) ){
      strValue[index++] = ch; // add the ASCII character to the string;
    }
    else
    {
      // here when buffer full or on the first non digit
      strValue[index] = 0;        // terminate the string with a 0
      blinkDelay = atoi(strValue);  // use atoi to convert the string to an int
      index = 0;
    }
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  }
  blink();
}  

void blink()
{
   digitalWrite(ledPin, HIGH);
   delay(blinkDelay/2);  // wait for half the blink period 
   digitalWrite(ledPin, LOW);
   delay(blinkDelay/2);  // wait for the other half 
}

Discussion
The obscurely named atoi (for ASCII to int) and atol (for ASCII to long) functions
convert a string into integers or long integers. To use them, you have to receive and
store the entire string in a character array before you can call the conversion function.
The code creates a character array named strValue that can hold up to five digits (it’s
declared as char strValue[6] because there must be room for the terminating null). It
fills this array with digits from Serial.read until it gets the first character that is not a
valid digit. The array is terminated with a null and the atoi function is called to convert
the character array into the variable blinkDelay.

A function called blink is called that uses the value stored in blinkDelay.

As mentioned in the warning in Recipe 2.4, you must be careful not to exceed the bound
of the array. If you are not sure how to do that, see the Discussion section of that recipe.

Arduino release 22 added the toInt method to convert a String to an integer:

 String aNumber = "1234";
 int value = aNumber.toInt();

Arduino 1.0 added the parseInt method that can be used to get integer values from
Serial and Ethernet (or any object that derives from the Stream class). The following
fragment will convert sequences of numeric digits into numbers. It is similar to the
solution fragment but does not need a buffer (and does not limit the number of digits
to 5):

void loop()
{
  if( Serial.available())
  {
    blinkRate = Serial.parseInt();
  }
  blink();
}
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Stream-parsing methods such as parseInt use a timeout to return con-
trol to your sketch if data does not arrive within the desired interval.
The default timeout is one second but this can be changed by calling
the setTimeout method:

Serial.setTimeout(1000 * 60); // wait up to one minute

parseInt (and all other stream methods) will return whatever value was
obtained prior to the timeout if no delimiter was received. The return
value will consist of whatever values were collected; if no digits were
received, the return will be zero. Arduino 1.0 does not have a way to
determine if a parse method has timed out, but this capability is planned
for a future release.

See Also
Documentation for atoi can be found at: http://www.nongnu.org/avr-libc/user-manual/
group__avr__stdlib.html.

There are many online C/C++ reference pages covering these low-level functions, such
as http://www.cplusplus.com/reference/clibrary/cstdlib/atoi/ or http://www.cppreference
.com/wiki/string/c/atoi.

See Recipe 4.3 and Recipe 4.5 for more about using parseInt with Serial.

2.10  Structuring Your Code into Functional Blocks
Problem
You want to know how to add functions to a sketch, and the correct amount of func-
tionality to go into your functions. You also want to understand how to plan the overall
structure of the sketch.

Solution
Functions are used to organize the actions performed by your sketch into functional
blocks. Functions package functionality into well-defined inputs (information given to
a function) and outputs (information provided by a function) that make it easier to
structure, maintain, and reuse your code. You are already familiar with the two func-
tions that are in every Arduino sketch: setup and loop. You create a function by
declaring its return type (the information it provides), its name, and any optional pa-
rameters (values) that the function will receive when it is called.
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The terms functions and methods are used to refer to well-defined blocks
of code that can be called as a single entity by other parts of a program.
The C language refers to these as functions. Object-oriented languages
such as C++ that expose functionality through classes tend to use the
term method. Arduino uses a mix of styles (the example sketches tend
to use C-like style, libraries tend to be written to expose C++ class
methods). In this book, the term function is usually used unless the code
is exposed through a class. Don’t worry; if that distinction is not clear
to you, treat both terms as the same.

Here is a simple function that just blinks an LED. It has no parameters and doesn’t
return anything (the void preceding the function indicates that nothing will be
returned):

// blink an LED once
void blink1()
{
   digitalWrite(13,HIGH);   // turn the LED on
   delay(500);              // wait 500 milliseconds
   digitalWrite(13,LOW);    // turn the LED off
   delay(500);              // wait 500 milliseconds
}

The following version has a parameter (the integer named count) that determines how
many times the LED will flash:

// blink an LED the number of times given in the count parameter
void blink2(int count)
{
  while(count > 0 )  // repeat until count is no longer greater than zero
  {
    digitalWrite(13,HIGH);
    delay(500);
    digitalWrite(13,LOW);
    delay(500);
    count = count -1; // decrement count
  }
}

Experienced programmers will note that both functions could be blink
because the compiler will differentiate them by the type of values used
for the parameter. This behavior is called function overloading. The Ar-
duino print discussed in Recipe 4.2 is a common example. Another
example of overloading is in the discussion of Recipe 4.6.

That version checks to see if the value of count is 0. If not, it blinks the LED and then
reduces the value of count by one. This will be repeated until count is no longer greater 
than 0.
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A parameter is sometimes referred to as an argument in some documen-
tation. For practical purposes, you can treat these terms as meaning the
same thing.

Here is an example sketch that takes a parameter and returns a value. The parameter
determines the length of the LED on and off times (in milliseconds). The function
continues to flash the LED until a button is pressed, and the number of times the LED
flashed is returned from the function:

/*
  blink3 sketch
  Demonstrates calling a function with a parameter and returning a value.
  Uses the same wiring as the pull-up sketch from 
  Recipe 5.2
  
  The LED flashes when the program starts and stops when a switch connected
  to digital pin 2 is pressed.
  The program prints the number of times that the LED flashes.
 */

const int ledPin = 13;          // output pin for the LED
const int inputPin = 2;         // input pin for the switch

void setup() {
  pinMode(ledPin, OUTPUT);
  pinMode(inputPin, INPUT);
  digitalWrite(inputPin,HIGH); // use internal pull-up resistor (Recipe 5.2)
  Serial.begin(9600);
}

void loop(){
  Serial.println("Press and hold the switch to stop blinking");
  int count = blink3(250); // blink the LED 250ms on and 250ms off
  Serial.print("The number of times the switch blinked was ");
  Serial.println(count);
}

// blink an LED using the given delay period
// return the number of times the LED flashed
int blink3(int period)
{
  int result = 0;
  int switchVal = HIGH; //with pull-ups, this will be high when switch is up

  while(switchVal == HIGH)  // repeat this loop until switch is pressed
                            // (it will go low when pressed)
  {
    digitalWrite(ledPin,HIGH);
    delay(period);
    digitalWrite(ledPin,LOW);
    delay(period);
    result = result + 1; // increment the count

2.10  Structuring Your Code into Functional Blocks | 47



    switchVal = digitalRead(inputPin);  // read input value
  }
  // here when switchVal is no longer HIGH because the switch is pressed
  return result;  // this value will be returned
}

Discussion
The code in this recipe’s Solution illustrates the three forms of function call that you
will come across. blink1 has no parameter and no return value. Its form is:

void blink1()
{
   // implementation code goes here...
}

blink2 takes a single parameter but does not return a value:

void blink2(int count)
{
   // implementation code goes here...
}

blink3 has a single parameter and returns a value:

int blink3(int period)
{
   // implementation code goes here...
}

The data type that precedes the function name indicates the return type (or no return
type if void). When declaring the function (writing out the code that defines the function
and its action), you do not put a semicolon following the parenthesis at the end. When
you use (call) the function, you do need a semicolon at the end of the line that calls the
function.

Most of the functions you come across will be some variation on these forms. For
example, here is a function that takes a parameter and returns a value:

int sensorPercent(int pin)
{
int percent;

  int val = analogRead(pin);  // read the sensor (ranges from 0 to 1023)
  percent = map(val,0,1023,0,100); // percent will range from 0 to 100.
  return percent;
}

The function name is sensorPercent. It is given an analog pin number to read and
returns the value as a percent (see Recipe 5.7 for more on analogRead and map). The
int in front of the declaration tells the compiler (and reminds the programmer) that
the function will return an integer. When creating functions, choose the return type
appropriate to the action the function performs. This function returns an integer value
from 0 to 100, so a return type of int is appropriate.
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It is recommended that you give your functions meaningful names, and
it is a common practice to combine words by capitalizing the first letter
of each word, except for the first word. Use whatever style you prefer,
but it helps others who read your code if you keep your naming style
consistent.

sensorPercent has a parameter called pin (when the function is called, pin is given the
value that is passed to the function).

The body of the function (the code within the brackets) performs the action you want—
here it reads a value from an analog input pin and maps it to a percentage. In the
preceding example, the percentage is temporarily held in a variable called percent. The
following statement causes the value held in the temporary variable percent to be re-
turned to the calling application:

   return percent;

The same functionality can be achieved without using the percent temporary variable:

int sensorPercent(int pin)
{
  int val = analogRead(pin);  // read the sensor (ranges from 0 to 1023)
  return map(val,0,1023,0,100); // percent will ranges from 0 to 100.
}

Here is how the function can be called:

// print the percent value of 6 analog pins
for(int sensorPin = 0; sensorPin < 6; sensorPin++)
{
  Serial.print("Percent of sensor on pin ");
  Serial.print(sensorPin);
  Serial.print(" is ");
  int val = sensorPercent(sensorPin);
  Serial.print(val);
}

See Also
The Arduino function reference page: http://www.arduino.cc/en/Reference/FunctionDe
claration

2.11  Returning More Than One Value from a Function
Problem
You want to return two or more values from a function. Recipe 2.10 provided examples
for the most common form of a function, one that returns just one value or none at all.
But sometimes you need to modify or return more than one value.
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Solution
There are various ways to solve this. The easiest to understand is to have the function
change some global variables and not actually return anything from the function:

/*
  swap sketch
  demonstrates changing two values using global variables
 */

int x; // x and y are global variables
int y;

void setup() {
  Serial.begin(9600);
}

void loop(){
  x = random(10); // pick some random numbers
  y = random(10);

  Serial.print("The value of x and y before swapping are: ");
  Serial.print(x); Serial.print(","); Serial.println(y);
  swap();

  Serial.print("The value of x and y after swapping are: ");
  Serial.print(x); Serial.print(","); Serial.println(y);Serial.println();

  delay(1000);
}

// swap the two global values
void swap()
{
  int temp;
  temp = x;
  x = y;
  y = temp;
}

The swap function changes two values by using global variables. Global variables are
easy to understand (global variables are values that are accessible everywhere and any-
thing can change them), but they are avoided by experienced programmers because it’s
easy to inadvertently modify the value of a variable or to have a function stop working
because you changed the name or type of a global variable elsewhere in the sketch.

A safer and more elegant solution is to pass references to the values you want to change
and let the function use the references to modify the values. This is done as follows:

/*
  functionReferences sketch
  demonstrates returning more than one value by passing references
 */
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void setup() {
  Serial.begin(9600);
}

void loop(){
  int x = random(10); // pick some random numbers
  int y = random(10);

  Serial.print("The value of x and y before swapping are: ");
  Serial.print(x); Serial.print(","); Serial.println(y);
  swap(x,y);

  Serial.print("The value of x and y after swapping are: ");
  Serial.print(x); Serial.print(","); Serial.println(y);Serial.println();

  delay(1000);
}

// swap the two given values
void swap(int &value1, int &value2)
{
  int temp;
  temp = value1;
  value1 = value2;
  value2 = temp;
}

Discussion
The swap function is similar to the functions with parameters described in
Recipe 2.10, but the ampersand (&) symbol indicates that the parameters are refer-
ences. This means changes in values within the function will also change the value of
the variable that is given when the function is called. You can see how this works by
first running the code in this recipe’s Solution and verifying that the parameters are
swapped. Then modify the code by removing the two ampersands in the function def-
inition.

The changed line should look like this:

void swap(int value1, int value2)

Running the code shows that the values are not swapped—changes made within the
function are local to the function and are lost when the function returns.

If you are using Arduino release 21 or earlier, you will need to create a
function declaration to inform the compiler that your function is using
references. The sketch for this recipe in the download for the first edition
of this book shows how to create the function declaration:

// functions with references must be declared before use
// The declaration goes at the top, before your setup and loop code
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